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Abstract
Proteome integrity is a prerequisite for cellular functionality and organismal viability. Its com-

promise is considered an inherent part of the aging process and has been associated with the

onset of age-related, neurodegenerative pathologies. Although the molecular underpinnings of

protein homeostasis (proteostasis) have been extensively studied, several aspects of its regu-

lation remain elusive. The nematode Caenorhabditis elegans has emerged as a versatile,

heterologous model organism to study the dynamics of aggregation-prone human proteins

in vivo. Here, we describe an experimental pipeline for the analysis of polyglutamine (polyQ)

tract aggregation, as a measure of the state of proteostasis, during aging.

Abbreviations
APS ammonium persulfate

DRPLA dentatorubral-pallidoluysian atrophy

DTT dithiothreitol

HD Huntington’s disease

LB Luria-Bertani

NGM nematode growth media

PN proteostasis network

polyQ polyglutamine

Q glutamine

ROI region of interest

RT room temperature

SBMA spinal and bulbar muscular atrophy

SDS sodium dodecyl sulfate

TBS tris-buffered saline

TBS-T tris-buffered saline supplemented with Tween-20

TEMED tetramethylethylenediamine

WLB worm lysis buffer

1 Introduction
Proteome integrity is constantly undermined by extrinsic stressful insults, as well as

endogenous by-products of cellular metabolism. A significant fraction of the prote-

ome across the evolutionary spectrum is dedicated to proteostasis surveillance
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(Muller et al., 2020), underlining the paramount importance of maintaining a healthy

protein repertoire for preserving cellular, tissue, and organismal homeostasis. The

proteostasis network (PN), comprised of an elaborate array of chaperones and

proteolytic degradation machineries coordinated by transcriptional stress response

pathways, safeguards proteome integrity (Higuchi-Sanabria et al., 2018; Hipp,

Kasturi, & Hartl, 2019). Of particular note, the competence of the PN declines with

aging, contributing to the manifestation of late-onset proteinopathies (David et al.,

2010; Lopez-Otin et al., 2013). Hence, decelerating PN decline has emerged as a prom-

ising strategy to relieve the elderly of the deleterious consequences of proteotoxicity.

The pathogenic expansion of the CAG trinucleotide, coding for glutamine (Q),

underlies the manifestation of nine neurodegenerative disorders, including

Huntington’s disease (HD), spinal and bulbar muscular atrophy (SBMA),

dentatorubral-pallidoluysian atrophy (DRPLA) and six autosomal dominant forms

of spinocerebellar ataxia (SCA1, 2, 3, 6, 7, and 17). All polyglutamine (polyQ) disor-

ders are characterized by similar clinical and pathological outcomes, albeit the affected

genes do not share genetic or functional homology (Lieberman, Shakkottai, & Albin,

2019). Mutant proteins harboring elongated polyQ tracts become unstable, undergoing

conformational changes that render them prone to aggregation. The transition from

native monomers to intermediate oligomers and eventually insoluble aggregates

has been described in vitro and confirmed in vivo (Minakawa & Nagai, 2021).

Aggregation-prone proteins implicated in polyQ disorders are widely expressed

throughout the body, but degeneration mainly occurs in specific brain regions.

Accumulating evidence suggests that peripheral cells, such as cardiomyocytes, skel-

etal muscles, gastrointestinal cells and hepatocytes, may also accumulate polyQ

aggregates, thus contributing to pathology (Huang et al., 2019; Sathasivam et al.,

1999; Singh & Agrawal, 2021).

A multitude of studies using invertebrate and vertebrate animal models have

indicated that overexpression of an extended polyQ tract is sufficient to induce neu-

ronal degeneration in vivo (C. elegans: (Morley et al., 2002), Drosophila: (Marsh

et al., 2000), zebrafish: (Miller et al., 2005) and mice: (Ordway et al., 1997)). Animal

models are instrumental for deciphering the regulatory mechanisms that govern

polyQ homeostasis on the organismal level and testing potential therapeutic strate-

gies to alleviate protein aggregation. During the last two decades, polyQ tracts

of different lengths have been successfully expressed in various C. elegans tissues
(Brignull et al., 2006; Gidalevitz et al., 2006; Morley et al., 2002; Moronetti

Mazzeo et al., 2012; Sinnige et al., 2021). With particular interest for this review,

Moronetti Mazzeo and colleagues generated a transgenic strain where the expression

of a fluorescently-tagged Q44 stretch is driven by the intestine-specific promoter

vha-6 (pvha-6Q44::YFP) (Moronetti Mazzeo et al., 2012). Intestinal Q44::YFP was

reported to aggregate during aging or upon administration of osmotic stress

(Moronetti Mazzeo et al., 2012). Another report also documented a role of macro-

autophagy, a central self-degradation cellular process, in preserving Q44::YFP

homeostasis (Kumsta et al., 2017).

Here, we thoroughly describe an experimental procedure for assessing protein

aggregation of the Q44::YFP transgene in C. elegans. Specifically, we report an
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in vivo imaging method to visualize and quantify Q44::YFP foci number and size

during aging. Additionally, we analyze a biochemical protocol based on sodium

dodecyl sulfate (SDS) protein solubility and Western blot analysis to estimate the

insoluble vs. soluble Q44::YFP fraction. We anticipate that this protocol, appropri-

ately modified or adjusted, can be leveraged for monitoring the dynamics of various

aggregation-prone proteins, implicated in human pathology, in C. elegans.

2 Materials
2.1 Disposables
1. Microscope slides (25.4�76.2�1mm)

2. Microscope coverslips (18�18mm)

3. Fingernail polish for sealing the coverslips

4. Standard platinum wire pick: for transferring the worms to NGM plates

5. Eyelash hair attached to a toothpick: for transferring the worms on agarose pads

6. Petri plates (60�15mm) for the maintenance of C. elegans nematodes

7. Petri plates (92�16mm) for bacterial growth

8. Agarose pads: Add 0.5g agarose into 25mL distilled water (H2O). Heat the

solution until the agarose is completely dissolved. While the agarose is still hot,

leave a droplet (approximately 1cm in diameter) in the middle of a microscope

slide. Immediately place a second slide on the top of it, and press it until

the agarose droplet is flattened to a bigger circle. Wait for about 2min and

carefully remove the second slide, trying not to disturb the agarose droplet.

The agarose pad is ready for use in about 5min.

9. Micropipettes (1–20, 20–200, 200–1000μL) and tips

10. 1.5mL microcentrifuge tubes

11. 50mL plastic conical tubes

12. Glass conical flasks for bacterial cultures

13. 96-well microplates with flat bottom for protein quantification

14. Filter paper (e.g., Whatman® Filter paper)

15. Nitrocellulose membrane (e.g., Amersham Protran Western blotting membrane

0.2μm)

16. 0.5mm zirconium oxide beads (e.g., Next Advance)

2.2 Equipment
1. Stereomicroscope (e.g., Nikon SMZ 745)

2. Fluorescent microscope (e.g., Zeiss AxioImager Z2 epifluorescence microscope)

3. Standard tabletop centrifuge

4. Refrigerated centrifuge

5. Microplate absorbance reader (e.g., Spark® Multimode Microplate Reader,

Tecan) for protein quantification

6. Tissue homogenizer (e.g., Bullet Blender, Next Advance)
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7. Power supply, vertical electrophoresis system and blotting systems (e.g.,

Mini-PROTEAN® Tetra Vertical Electrophoresis Cell, 4-gel, for 1.0mm thick

handcast gels, with Mini Trans-Blot® Module, Bio-Rad)

8. Laboratory shaker or rocker

9. Chemiluminescence developing system (e.g., Chemidoc Imaging System, Bio-Rad)

2.3 Nematode strains
1. N2: C. elegans wild isolate

2. OG412: drIs20 [pvha-6Q44::YFP+ rol-6(su1006)+pBluescript II]

2.4 Nematode food
OP50: Uracil auxotroph E. coli bacteria. For liquid OP50 bacterial culture, inoculate
a single OP50 colony (grown overnight on an LB agar plate) into 50mL of sterile

liquid LB medium. Incubate for 4–5h in a shaking incubator at 37 °C. Seed

200μL of the OP50 culture in the middle of freshly prepared NGM plates, and let

them grow overnight at room temperature (RT) (for approximately 16h).

2.5 Reagents
2.5.1 Reagents for bacterial cultures
1. Luria-Bertani (LB) liquid medium: For the preparation of 1L liquid LB medium,

dissolve 10g sodium chloride (NaCl), 10g Tryptone and 5g yeast extract in

900mL distilled H2O. Stir the mix until it is completely dissolved. Adjust the pH

to 7.0 with sodium hydroxide (NaOH), and bring the volume to 1L with

H2O. Sterilize by autoclaving.

2. LB solid medium: For the preparation of 1L solid LB, mix the ingredients of the

aforementioned recipe for liquid LB with 15g agar in 700mL distilled

H2O. The powder will not dissolve completely, as agar is only dissolved after

autoclaving. Adjust the pH to 7.0 with NaOH and sterilize by autoclaving. Bring

the volume to 1L with sterile H2O and when the medium is cooled enough

(approximately 50 °C), dispense it to petri plates [approximately 18mL per plate

(92�16mm)].

2.5.2 Reagents for nematode growth and maintenance
1. Nematode Growth Media (NGM): To prepare 1L of NGM, dissolve 3g NaCl,

2.5g bactopeptone, 17g agar and 0.2g streptomycin in 800mL distilled

H2O. Sterilize by autoclaving. After the solution has cooled down (approximately

50 °C), add 1mL of 1M calcium chloride (CaCl2), 1mL of 1M magnesium

sulfate (MgSO4), 25mL of 1M potassium phosphate (KPO4), 1mL of cholesterol

(5mg/mL in 100% ethanol) and 1mL Nystatin (10mg/mL in 70% ethanol).

All the solutions, except for cholesterol and Nystatin, need to be sterilized by

autoclaving. Bring the volume to 1L with sterile H2O, and after 5-10min of

stirring, dispense the solution to petri plates (7mL per 60�15mm plate).
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2. M9Minimal Medium Buffer: Dissolve 3g monopotassium phosphate (KH2PO4),

6g disodium phosphate (Na2HPO4) and 5g NaCl in 800mL distilled

H2O. Sterilize by autoclaving. After the solution has cooled down, add 1mL of

sterile 1M magnesium sulfate (MgSO4), and bring the volume to 1L with

distilled water.

3. Bleaching solution for synchronizing nematode population: To prepare 10mL of

bleaching solution, add 1mL of 5N NaOH and 2mL of 5% sodium hypochlorite

(NaOCl) in 7mL distilled H2O.

4. Tetramisole for anesthetizing the nematodes: To prepare 100mM stock

tetramisole solution, dissolve 0.24g tetramisole hydrochloride powder in 10mL

M9 buffer. Keep it as a stock solution at 4 °C. For the working solution, dilute the
stock in M9 at a final concentration of 20mM and keep it at RT.

2.5.3 Reagents for the biochemical detection of polyQ aggregates
1. Worm Lysis Buffer (WLB): To prepare 10mLWLB mix 200μL of 1M Tris-Cl

pH 7.4 stock solution (20mM final concentration), 200μL of 1M NaCl stock

solution (20mM final concentration) and 10μL of 1M MgCl2 stock solution

(1mM final concentration). Bring the volume to 10mL with distilled H2O and

keep it at RT.

2. Urea Lysis Buffer: To prepare 1mL Urea Lysis Buffer, add 0.48g Urea

(8M final concentration), 200μL 10% (w/v) SDS buffer (2% (w/v) final
concentration), 25μL of 1M Tris-Cl pH 8.0 stock solution (50mM final

concentration) and 25μL of 1M dithiothreitol (DTT) stock solution (50mM

final concentration). Bring the volume to 1mL with distilled H2O and keep it at

RT to avoid SDS precipitation. Add the DTT immediately before use.

3. Protease inhibitors (e.g., cOmplete™, Mini Protease Inhibitor Cocktail, Roche).

4. 6� sample buffer for SDS PAGE protein sample preparation: To prepare

10mL solution, mix 3.75mL of 1MTris-Cl pH 6.8 stock solution (375mM final

concentration), 1.2g SDS (12% (w/v) final concentration), 6mL glycerol

(60% (v/v) final concentration), 6mg bromophenol blue (0.06% (w/v) final
concentration) and 120μL β-mercaptoethanol (12% (v/v) final concentration).
Warm the solution at 40 °C to avoid the formation of SDS precipitates. Bring

the final volume to 10mL with distilled H2O. Aliquote per 1mL and store

at 20 °C. Avoid freeze-thaw cycles. Once thawed, a vial is stable for several

weeks at RT.

5. 10% (w/v) SDS: Dissolve 5g SDS in 50mL distilled H2O. Store at RT.

6. Acrylamide-Bisacrylamide 37.5:1 mix (e.g., Acrylamide 4K solution 30%

(w/v), AppliChem).

7. 10% (w/v) APS: Dissolve 5g ammonium persulfate (APS) in 50mL distilled

H2O. Aliquote and store at �20 °C.
8. Tetramethylethylenediamine (TEMED).

9. 10% SDS polyacrylamide resolving gel: In a plastic conical tube mix 1.5mL of

1.5M Tris-Cl pH 8.8 stock solution, 2mL 30%Acrylamide-Bisacrylamide mix,

2.5mL distilled H2O, 60μL 10%(w/v) SDS. Vortex briefly. Add 60μL 10%
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(w/v) APS and 6μL TEMED immediately before casting the gel, as the addition

of APS and TEMED will initiate the polymerization of acrylamide.

10. 5% Stacking gel: In a plastic conical tube mix 0.75mL of 0.5M Tris-Cl pH 6.8

stock solution, 0.45mL 30% Acrylamide-Bisacrylamide mix, 1.77mL distilled

H2O, 30μL 10% SDS. Vortex briefly. Add 30μL 10% APS (w/v) and 3μL
TEMED immediately before casting the gel.

11. 10� Running buffer: For 1L add 30g Tris-Base (250mM final concentration),

144g glycine (1.92M final concentration) and 10g SDS (1%(w/v) final
concentration) in 1L distilled H2O. Store at RT and dilute 1:10 in distilled H2O

to prepare the 1� working solution.

12. 1� Transfer buffer: For 2L dissolve 6g Tris-Base (25mM final concentration)

and 28.8g glycine (192mM final concentration) in 1.6L distilled H2O. Stir until

both chemicals are dissolved. Then add 400mL methanol (20% (v/v) final
concentration) and store at 4 °C until use. Transfer buffer can be reused for at

least two times.

13. 10� Tris-Buffered Saline (TBS) pH 7.6: For 1L add 24g Tris-base (200mM

final concentration) and 88g NaCl (1.5M final concentration) in 900mL

distilled H2O. Adjust pH to 7.6 with 12N HCl and bring the volume to 1L with

distilled H2O.

14. 1� TBS supplemented with 0.1% Tween-20 (TBS-T): To prepare 1L add

100mL 10� TBS in 900mL distilled H2O. Then use a tip with a cut end to add

1mL Tween-20. Stir until the detergent is dissolved.

15. Ponceau S solution: To prepare 100mL solution, dissolve 0.5g Ponceau S in

5mL acetic acid. Bring the final volume to 100mL with distilled H2O. The

solution can be reused multiple times.

16. 5% Blocking buffer: Dissolve 2g non-fat milk powder in 40mL 1� TBS-T.

17. Antibodies: Primary antibodies: anti-GFP, anti-α-tubulin and secondary

HRP-conjugated antibodies.

18. Chemiluminescence detection kit (e.g., Pierce™ ECL Western blotting

Substrate, Thermo Scientific).

19. Protein quantification kit (e.g., Pierce™ BCA Protein Assay Kit, Thermo

Scientific).

3 Methods
3.1 Microscopic analysis for monitoring polyQ aggregation
3.1.1 Nematode preparation for imaging in the microscope
1. Transfer five L4-staged nematodes of the OG412 strain in two OP50-seeded

NGM plates and incubate them at 20 °C.
2. After about 5 days, the plates will be full of gravid adult hermaphrodites. Wash

them with 1.5mL of M9 buffer and collect the liquid in a sterile 1.5mL

microcentrifuge tube. Allow the animals to settle by gravity for 2min and discard

the liquid. Add 500μL of freshly-made bleaching solution. Shake by hand or
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vortex the solution for a few seconds. Repeat shaking/vortexing every 2min until

the worm bodies are completely dissolved. Do not bleach for more than 5min, as

the resulting eggs may not hatch. Spin the tube in a tabletop centrifuge

(�3000rpm) for 30s to pellet the eggs. Discard the supernatant and wash the egg

pellet with 500μL sterile M9 buffer. Centrifuge once more using the same

conditions and resuspend the egg pellet in 100μL sterile M9 buffer. Dispense the

egg solution to OP50-seeded plates. Allow the animals to grow at 20 °C.
3. After about 3.5 days, the plates will be full of young day 1 adult animals. Use at

least 25–30 worms for microscopic observation (day 1 sample). Transfer

adequate number of animals to new OP50-seeded plates (25–30 animals per

plate) and incubate them at 20 °C. The following days use 25–30 animals for

microscopic observation (day 3, 4, 5, 6, 7, 8, 10 samples). Ensure to transfer the

animals to new OP50-seeded plates when needed to prevent bacteria depletion.

4. Place a 5μL drop of 20mM tetramisole in the middle of a freshly made

agarose pad.

5. Transfer worms to the droplet using an eyelash hair attached to a toothpick.

6. Cover with a coverslip and seal with fingernail polish, to prevent animals drying

out during the imaging process.

7. Observe the worms under a fluorescent microscope at 10� magnification and

acquire images of whole animal bodies. Ignore animals that seem to be damaged

(mainly due to mishandling during preparation). Ensure that all images are

acquired by using the same settings (i.e., exposure time, brightness, contrast) and

include a scale bar.

3.1.2 Image analysis for quantification and characterization of polyQ
aggregates using the FIJI software
1. Open the first image in FIJI and with the “Straight” tool draw a line of the same

length with the scale bar. From the “Analyze” menu select “Set scale.” In the

dialog box enter the “Known distance” based on the scale bar and select the

appropriate unit of length. Select the “Global” function, in order to automatically

apply the calibration to the rest of the images.

2. In the opened image select the whole animal body by using a selection tool and

add the selected Region of Interest (ROI) in the ROI Manager

(Edit!Selection!Add to Manager). Repeat for all the animals in the image.

3. When all ROIs are added in the ROI manager, from the “Image” menu select

“Color” and “Split channels.” Keep only the image of the green channel.

4. If necessary, from the “Process” menu select “Subtract background” and in the

opened dialog box set the appropriate “Rolling ball radius” to remove the

background noise.

5. From the “Image” menu select “Adjust” and “Threshold.” In the opened dialog

box set the second bar at the maximum level (255), adjust the upper bar at a level

where all the puncta are visible (we usually set it at 70, but it depends on the

image acquisition settings) and press “Apply.”
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6. For each ROI run the “Analyze particles” command from the “Analyze” menu. In

the opened dialog box, in the “Show” menu select “Outlines” and ensure that you

have ticked “Display results,” “Summarize” and “Exclude on edges.”

7. Repeat steps 2–7 for all images. Save the “Results” data, containing information

regarding the puncta size and the “Summary” data, containing information

regarding particle number per worm.

8. Perform the statistical analysis usingMicrosoft Excel or Graphpad Prism softwares.

Once image processing parameters (i.e., subtract background setting and threshold

values) are standardized to accurately select puncta, a macro may be used to auto-

mate the analysis of Q44::YFP particles in selected ROIs. Using the macro shown in

Fig. 1, we analyze the puncta number and size in images containing multiple worms.

For the automated analysis, calibrate the scale as described in step 1 and modify

the macro command in order to appropriately select the rolling ball radius and

threshold values (macro lines 11, 14). For each image, add all ROIs of the picture

in the ROI manager and run the macro. The macro generates a dialog to select a

working space on the computer, for example, the desktop. All subsequent steps

are performed automatically and the “Results” data and “Summary” data are pro-

duced. Using the aforementioned analysis, we show that the mean number and size

of Q44::YFP aggregates significantly increase during aging (Fig. 2A–C).

FIG. 1

Overview of the semi-automated analysis for estimating the number and size of Q44::YFP foci.
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FIG. 2

Microscopic analysis combined with SDS protein solubility assay for monitoring Q44::YFP

dynamics during C. elegans lifespan. (A) Longitudinal analysis of Q44::YFP aggregation in

wild-type animals. Red inboxes highlight representative intestinal regions. Scale bar,

200μm. (B) Quantification of intestinal Q44::YFP foci number per animal in different days of

adulthood (N¼25 animals; ***p<0.001, **p<0.01; one-way ANOVA; error bars, SD).

(C) Quantification of Q44::YFP foci size (μm2) in different days of adulthood (N¼25 animals;

**p<0.01, *p<0.05; one-way ANOVA; error bars, SD). (D) Western blot against Q44::

YFP and α-tubulin proteins. 1μg of N2 and OG412 lysates were used as inputs to validate

equal protein content between samples and ensure antibody specificity against the Q44::YFP

protein. A prominent band at approximately 40kD corresponds to the Q44::YFP protein.

α-tubulin was used as a loading control.
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3.2 Biochemical analysis of polyQ aggregation during aging
3.2.1 Nematode preparation for biochemical analysis of polyQ aggregation
1. Following the instructions described in Section 3.1.1 (steps 1–3), prepare at least

100 day 1 adult animals of the OG412 strain and collect them in a

microcentrifuge tube containing 1mL M9 buffer. Allow the animals to settle by

gravity for 2min and discard the liquid. Wash the worm pellet twice with M9,

flash-freeze it in liquid nitrogen and store it at �80 °C. Follow the same

procedure to obtain additional time-point samples.

2. In parallel prepare 100 day 1 adult animals of the wild-type (N2) strain following

the instructions described above and store the worm pellet in �80 °C. N2 lysate

will be used as control sample, to distinguish Q44::YFP specific bands.

3.2.2 SDS solubility assay
1. Thaw worm pellets on ice (4 °C) and aspirate the supernatant liquid if needed.

2. Estimate the volume of each worm pellet (approximately 20–30μL) and add an
equal volume of 0.5mm zirconium oxide beads to each microcentrifuge tube.

3. Add at least 2 volumes of WLB supplemented with 1� protease inhibitors

(WLB+PI) to each microcentrifuge tube. Due to the small volume of the worm

pellets (20–30μL), we recommend adding 100μL WLB+PI for efficient

homogenization.

4. Perform the homogenization using a tissue homogenizer at 4 °C. For the Bullet
Blender (Next Advance) adjust the following settings: Speed!10,

Time!3min

5. Visually inspect the lysates to ensure complete homogenization. If necessary

repeat the homogenization process once using the same settings.

6. Leave the beads to settle by gravity and transfer the lysates to new

microcentrifuge tubes.

7. Determine protein concentration of each sample by using a protein

quantification kit (e.g., Pierce™ BCA Protein Assay Kit, Invitrogen).

8. Dilute all samples with WLB+PI, in order to achieve equal concentration.

Keep 1μg of each sample as input and use an equal amount of each sample

(we used 25μg) to proceed.

9. Centrifuge at 17000g for 15min at 4 °C.
10. Without disturbing the pellets, transfer the supernatants to new microcentrifuge

tubes, and store them on ice as the “aqueous-soluble protein fractions.”

11. Resuspend the pellets in 50μL WLB+PI supplemented with 1% (w/v) SDS.
Care must be taken to use the exact same volume of buffer in each sample, to

ensure the quantitative nature of analysis.

12. Centrifuge at 17000g for 15min at RT to avoid SDS precipitation.

13. Transfer the supernatants to new microcentrifuge tubes and store them at RT as

the “SDS-soluble protein fractions.”

14. Wash the pellets with 100μL WLB+PI supplemented with 1% (w/v) SDS.
15. Centrifuge at 17000g for 15min at RT. Discard the supernatants.
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16. Resuspend the pellets in 25μL of freshly-made Urea lysis buffer and incubate at

RT for 10min. Care must be taken to use the exact same volume of buffer in

each sample, to ensure the quantitative nature of analysis.

17. Dilute Urea-treated samples with 25μL WLB+PI supplemented with 1% (w/v)
SDS and store them as the “SDS-insoluble protein fractions.”

18. Add a suitable volume of 6� sample buffer to all samples in order to achieve a

final concentration of 1� and boil the samples at 95 °C for 5min.

3.2.3 Characterization of Q44::YFP protein solubility during aging
by Western blot
1. Assemble the glass plate and spacer in the gel casting apparatus following the

manufacturer’s guidelines. Prepare 6mL of 10% SDS-polyacrylamide resolving

gel, as described in Section 2.5.3. Add approximately 4.5mL of the

resolving gel and 1mL of isopropanol on top. Save the remaining quantity of the

resolving gel in the conical tube to check for gel polymerization. In parallel

prepare the stacking gel solution, without adding the polymerization factors

(APS and TEMED). When the resolving gel is polymerized, remove

isopropanol, and wash with dH2O. Add the polymerization factors to the

stacking gel solution, and pour it on top of the resolving gel, until the gel plate is

filled. Insert the comb to create the wells and allow polymerization to occur.

2. Once the gel is polymerized, remove the comb and place the gel in the

electrophoresis tank, according to the manufacturer’s instructions. Fill the tank

with 1� Running buffer. Use one of the wells to load a pre-stained protein

marker, in order to distinguish protein molecular weights. Load the samples and

perform the electrophoresis at 70V for 15min and then at 100–120V until

the bromophenol blue front reaches the end of the gel. Because there is no

loading control for different fractions, it is important to load in the gel the exact

same quantity among samples for every fraction, in order to perform a

quantitative analysis.

3. Once the electrophoresis is completed proceed to the wet transfer. Assemble the

transfer cassette containing the sponges, filter papers, nitrocellulose membrane

and gel, according to the manufacturer’s instructions and place it into the

transfer apparatus filled with ice-cold 1� Transfer buffer including a cooling

unit. Perform the transfer at 100V for 1h.

4. Once the transfer is completed you may optionally perform Ponceau-S staining

of the membrane, to ensure that proteins are properly transferred. To this end,

incubate the membrane with Ponceau-S solution for a few minutes in a

Tupperware on a shaker. Then wash the membrane using distilled H2O or

TBS-T, until the protein bands are detectable. Perform additional washes to

completely de-stain the Ponceau-S stain.

5. Incubate the membrane with 5% Blocking buffer on a shaker for 1h at RT.

6. Dilute the primary antibody (anti-GFP) in 5% Blocking buffer, according to the

data sheet and incubate the membrane with the diluted antibody overnight at 4 °
C on a shaker.
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7. The following day wash the membrane three times with TBS-T for 10min on a

shaker at RT.

8. Incubate the membrane with the suitable HRP-conjugated secondary antibody,

diluted in 5% Blocking buffer according to the datasheet for 1h at RT on a

shaker.

9. Wash the membrane three times with TBS-T.

10. Add the chemiluminescence substrate on the membrane and develop the

membrane signal using a Chemiluminescence developing system to detect

Q44::YFP.

11. Wash the membrane three times with TBS-T and repeat steps 6–10 for the

detection of α-tubulin. By using anti-GFP and anti-α-tubulin primary antibodies

generated in different species (e.g., rabbit and mouse), you may use the same

nitrocellulose membrane to detect both proteins. To this end, add 2% (w/v)
sodium azide (NaN3) in the dilution of anti-α-tubulin antibody, which will

inhibit the HRP activity of the secondary antibody used for GFP detection.

Otherwise, a second gel may be prepared and used to directly detect α-tubulin.

Our biochemical analysis reveals that aged day 6 adult animals show increased levels

of SDS-insoluble Q44::YFP compared to young day 1 adults, while the total levels of

Q44::YFP protein are not changed (Fig. 2D). Inversely, the levels of aqueous and

SDS-soluble Q44::YFP protein decrease in aged nematodes, indicating that Q44::

YFP transitions from a soluble to an aggregated state during aging. The enrichment

of SDS-insoluble fraction correlates with the elevated number and size of Q44::YFP

aggregates during aging (Figs. 2B and C).

4 Concluding remarks
In the current protocol, we describe two complementary approaches to assess Q44::

YFP dynamics in C. elegans. Fluorescent imaging followed by the semi-automated

analysis of foci number and size can serve as an accurate estimate of Q44::YFP ag-

gregation status. When combined with SDS protein solubility assay and subsequent

Western blot analysis, it can highlight differences in the ratio of soluble vs. insoluble

(aggregated) Q44::YFP. We suggest that a similar protocol, carefully adjusted to the

needs of each individual experiment, can be utilized to assess the dynamics of polyQ

tracts of variable length expressed in different nematode tissues (muscles, neurons,

etc.). Monitoring polyQ aggregation under various experimental conditions can

provide ample insight into the molecular mechanisms that underpin proteostasis

and unveil therapeutic interventions that can decelerate its decline during aging.

5 Notes
1. Animals should be reared under well-fed conditions for at least three generations

before initiating the experiment. Starvation may have a direct impact on

proteostasis, thereby affecting Q44::YFP aggregation.
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2. Our experience using the OG412 strain has shown that intestine-specific vha-6
expression is significantly elevated when nematodes are fed with previously

UV-crosslinked, dead OP50 bacteria. We can not exclude the possibility that the

quality of bacterial food (i.e., different standard bacterial strains used for

nematode maintenance) may have a direct impact on Q44::YFP total levels or

dynamics. Hence, in every experimental setup including the appropriate controls

should always be a priority.

3. The length of the polyQ tract strongly affects its aggregation propensity.

Moreover, we have observed tissue-specific differences, even when the length of

the polyQ tract is comparable. For example, the AM141 CGC strain expressing

Q40::YFP under a muscle-specific promoter exhibits entirely focal fluorescence,

even from day 1 of adulthood. This can be attributed to the relative transgene

overexpression levels (driven by different tissue-specific promoters), but also to

inherent differences in polyQ proteostasis among C. elegans tissues.
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